IMPULSE®•Link 4.1 WDS

Wireless Diagnostic System

Instruction Manual
Service Contact Information
For questions regarding service or technical information contact:

1-866-MAG-SERV
(1-866-624-7378)

Magnetek Material Handling
N49 W13650 Campbell Drive
Menomonee Falls, WI  53051

Telephone:  800-288-8178
Website:  www.magnetek.com
E-mail:  MHCustomerservice@magnetek.com

Fax Numbers:
Main:  800-298-3503
Sales:  262-783-3510
Service:  262-783-3508

Magnetek, Inc. has additional satellite locations for Canada and the United States. For more information, please visit http://www.magnetek.com.

©2017 MAGNETEK

All rights reserved. This notice applies to all copyrighted materials included with this product, including, but not limited to, this manual and software embodied within the product. This manual is intended for the sole use of the person(s) to whom it was provided, and any unauthorized distribution of the manual or dispersal of its contents is strictly forbidden. This manual may not be reproduced in whole or in part by any means whatsoever without the expressed written permission of MAGNETEK.
# Table of Contents

Service Contact Information ............................................................................................................................ 1

Warning and Caution ............................................................................................................................................. 3

Chapter 1 - Introduction ........................................................................................................................................ 4
  Overview ........................................................................................................................................................... 4
  System Requirements ...................................................................................................................................... 6

Chapter 2 - Installation ....................................................................................................................................... 6
  Software Installation ........................................................................................................................................ 6
  Installing your Hardware Key ........................................................................................................................... 7
  Importing your Drive Profiles ........................................................................................................................ 8
  Creating Communication Profiles using the Wizard ......................................................................................... 9
  Hardware Installation .................................................................................................................................... 10
  Wiring the Base Unit ...................................................................................................................................... 10
  Wiring the Remote Unit .................................................................................................................................. 11

Chapter 3 - Navigation ....................................................................................................................................... 13

Chapter 4 - Parameter Maintenance ................................................................................................................ 16
  Read from VFD ............................................................................................................................................... 16
  Write to VFD ............................................................................................................................................... 16
  Parameter File Display ................................................................................................................................. 17
  Modifying Parameters ................................................................................................................................. 17
  Security / Password Protection ..................................................................................................................... 18
  Parameter File Comparison ........................................................................................................................ 19
  Custom Defaults .......................................................................................................................................... 20

Chapter 5 - Monitor / Drive DataLogger Function .......................................................................................... 21
  Monitor ......................................................................................................................................................... 21
  Drive DataLogger ....................................................................................................................................... 21
  Fault Reset .................................................................................................................................................. 25

Chapter 6 - Additional Menu Features .......................................................................................................... 27
  Print Preview ............................................................................................................................................... 27
  Parameter File Conversion ........................................................................................................................... 28
  Keypad Simulator ....................................................................................................................................... 28
  Viewing Parameters .................................................................................................................................... 29
  Copying to the Clipboard ............................................................................................................................. 29

Chapter 7 - Troubleshooting ........................................................................................................................... 30
  Drive Fault References ................................................................................................................................ 30
  Communication Error References ............................................................................................................... 31
  Communication Profile Test ........................................................................................................................ 32
  Status Log .................................................................................................................................................... 32

Chapter 8 - Appendices ..................................................................................................................................... 33
  Appendix A: Wiring for IMPULSE®-Link WDS Base Unit ............................................................................... 33
  Appendix B: Serial Wiring for IMPULSE®-Link WDS Remote Unit .............................................................. 34
  Appendix C: Termination Resistor Location .................................................................................................. 38
  Appendix D: Quick Reference ....................................................................................................................... 40
Warning and Caution

DISCLAIMER OF WARRANTY

Magnetek, hereafter referred to as Company, assumes no responsibility for improper programming of a drive that resulted from use of this software. This software should only be used by a trained technician who has read and understands the contents of this manual. Normal use of this software may result in the drive parameters becoming modified. Improper programming of a drive can lead to unexpected, undesirable, or unsafe operation or performance of the drive. This may result in damage to equipment or personal injury. Company shall not be liable for economic loss, property damage, or other consequential damages or physical injury sustained by the purchaser or by any third party as a result of the use of this software. Company neither assumes nor authorizes any other person to assume for Company any other liability in connection with the sale or use of this software.

⚠️ WARNING ⚠️

1. Read this user manual in its entirety before installing IMPULSE®-Link 4.1 Wireless Diagnostic System.
2. DO NOT connect or disconnect wiring, or perform signal checks while the electrical power is ON.
3. Improper programming of a drive through the use of this software can lead to unexpected, undesirable, or unsafe operation or performance of the drive.

*Failure to observe these and other precautions indicated in this manual may expose the user to dangerous voltages, which may result in bodily harm. Damage to equipment may also occur.*

⚠️ CAUTION ⚠️

NOTICE

No patent liability is assumed with respect to the use of the information contained herein. Moreover, Magnetek is constantly improving its high quality product; therefore, the information contained in this manual is subject to change without notice. Every precaution has been taken in the preparation of this document. Nevertheless, Magnetek assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.
Chapter 1 - Introduction

Overview

IMPULSE®•Link 4.1 Wireless Diagnostic System (WDS) is a user friendly, Windows® based, interactive drive communication software and wireless hardware package. It is designed for communication from your PC over a local network or your company-wide network to various Magnetek drives.

IMPULSE®•Link 4.1 WDS consists of:

1. A Base Unit consisting of a wireless modem connected to a PC via a local or company network.
2. A Remote Unit consisting of a wireless modem, which is wired to your Magnetek drives and communicates wirelessly to the Base Unit.
3. IMPULSE®•Link 4.1 WDS Software connects wirelessly to cranes in your facility. A Wibu hardware key must be present in the computer’s USB port to unlock the software.

WDS Base Unit
Model Number: WDS-BASE
Description: NEMA 4/12 enclosure consists of an Ethernet wireless modem, power supply, enclosure-mounted antenna, wiring terminal blocks, and cable grips.

WDS Remote Unit
Model Number: WDS-REMOTE
Description: NEMA 4/12 enclosure consists of a serial-to-wireless modem, power supply, enclosure-mounted antenna, wiring terminal blocks, and cable grips.

Software and Hardware Key
Model Number: WDS-SOFTWARE
Description: USB Flash Drive containing the IMPULSE®•Link 4.1 WDS software and a Wibu hardware key.

Remote Antenna Kit
Model Number: WDS-ANTENNA
Description: Hardware and accessories to remotely mount the WDS antenna (up to 10 feet).

DC-Powered WDS Remote Unit
Model Number: WDS-REMOTE-DC
Description: NEMA 4/12 enclosure consists of a wireless modem, 90-350VDC input power supply, enclosure-mounted antenna, terminal blocks, and cable grips.

DIN Rail Power Supply
Model Number: WDS-PS
Description: DIN rail power supply for the RS-232 to RS-485 Converter.
SPECIFICATIONS

WDS Base Unit

Enclosure:        NEMA 4/12
Temperature:      32 to 104 °F (0 to 40 °C)
Humidity:        0-95% Non-condensing
Voltage:         115 VAC single-phase, 0.8 Amps
Radio Wattage:   1 Watt
Communication:   Ethernet TCP/IP
Frequency:        900 MHz, Frequency Hopping Spread spectrum

WDS Remote Unit

Environment:      NEMA 4/12
Temperature:      32 to 104 °F (0 to 40 °C)
Humidity:        0-95% Non-condensing
Voltage:         115 VAC single-phase, 0.8 Amps (optional DC version)
Radio Wattage:   1 Watt
Communication:   RS-485 (2-wire/4-wire) or RS-422 (4-wire)
Frequency:        900 MHz, Frequency Hopping Spread spectrum
Range:           100 to 300 feet (91.4 meters) line-of-sight typical from Base Unit
Serial Cable:    2 twisted pair shielded cable, 120Ω impedance (e.g. Belden 9842)

Supported Drives

IMPULSE®•Link 4.1 WDS supports the following Magnetek drives:

- IMPULSE®•G+/VG+ Series 4
- IMPULSE®•G+/VG+ Series 3
- IMPULSE®•G+/VG+ Series 2
- IMPULSE®•G+ Mini
- IMPULSE®•D+ HHP
- IMPULSE®•P3 Series 2
- OmniPulse™ DDC
- OmniPulse™ DSD
- MagnePulse™ DMC

NOTE: Although the IMPULSE® Series 2 drives are supported, a CMG5M communication board (P/N #140-10261) needs to be installed on each G+ or VG+ Series 2 drive. If a G5IN4 card is installed on an IMPULSE® Series 2 drive, an RS-485/232 converter kit (P/N 144-12545) is required.
System Requirements

PC Requirements
1. 256 MB RAM or greater
2. Minimum of 100 MB free hard-disk space available
3. Windows Vista, 7, 8, or 10

Network Requirements
If specified, customer-supplied IP addresses can be configured into each Base Unit during factory setup. A tool, the WDS Configurator, is also included on the installer Flash Drive to assist in scanning and configuring the IMPULSE®•Link 4.1 WDS Base and Remote Units.

NOTE: The maximum Ethernet cable length between devices is 328 feet (100 meters). The Ethernet connector type is RJ-45.

Chapter 2 - Installation

Software Installation

The IMPULSE®•Link 4.1 WDS Flash Drive contains: the IMPULSE®•Link 4.1 WDS Software installer.

- To run the IMPULSE®•Link 4.1 WDS Setup, insert the IMPULSE®•Link 4.1 WDS installer flash drive into a USB port on your PC. Run the included .exe file.
- Select the default choices during installation and click “Finish” when complete.
Installing your Hardware Key

Insert your WDS Wibu hardware key into a USB port on your computer. Windows will detect the hardware and begin installing the necessary drivers.

Select **Next**, leaving the *(Recommended)* choice selected. Wait while the hardware is installed. Windows will find the correct driver and install it.

Click **Finish** to close the **Found New Hardware Wizard** dialog.

**NOTE:** If you try to run IMPULSE®*•Link 4.1 WDS and the hardware key is not inserted into a USB port on the computer, you will receive the following error message. Also, if you are running IMPULSE®*•Link 4.1 WDS and remove the hardware key, the same message will appear until the key is re-inserted into the USB port.

Software Updates

Additional features and software enhancements may be available from time to time. These may be downloaded for free from the Magnetek Material Handling website at:

http://www.magnetekmh.com/Material Handling/Downloads
Importing your Drive Profiles

If you requested your crane profile and Ethernet IP address to be configured at the factory, your profile will reside on the installer Flash Drive. When IMPULSE®•Link 4.1 WDS is installed, the profiles will be imported automatically for you. When IMPULSE®•Link 4.1 WDS is launched, a splash screen will appear for a few seconds while it loads.

To import the profiles manually:

1. Select “Communication” from the Settings Menu.
2. Right-Click on the “Communication Profiles” Folder and select “Import From File”
3. Browse to the installer Flash Drive, select the files (*.CPX) and choose “Open”.
4. There will be a profile for each drive (Crane 1 Hoist, Crane 1 Bridge, etc.)
5. After the profiles are imported, select “OK” to save your communication profiles.
Creating Communication Profiles using the Wizard

If you need to create a communication profile, there is a wizard to assist you. In the Settings Menu, click “Communication,” and then right-click on the folder “Communications Profile” and choose “Add Crane Folder”.

Enter the name of your crane for the folder. Right-click on this new folder and choose “Add Profile”. You will then see the following screen appear:

Highlight the "IMPULSE DRIVE, TCP/IP to Serial Connection" type for the X2 model or the "IMPULSE DRIVE, WM-E" type for the XT model and the WDS Wireless Ethernet Modem, and then click “Select”. The wizard will then take you through the following four steps to set up a new communication profile.

1: Name, Description, Crane, and Motion
2: IP Address for the Base Unit
3: Select IP Port 14001 as required
4: Slave Address (01H to 1FH) and Parity (0:None)
5: Finish
6: To save, click OK on the Communication Profile screen

**NOTE:** Profiles will not be saved if Cancel is clicked
Hardware Installation

Mounting

Be sure that the Base and Remote Units are mounted in a location protected against the following conditions:

- Extreme cold or heat. Use within the ambient temperature range of: 32° to 104°F (0° to 40°C)
- Direct sunlight
- Direct rain, moisture
- High humidity: 0 to 95% Non-condensing
- Oil sprays, splashes
- Salt spray
- Corrosive gases

The Base and Remote Units should be mounted on a flat, non-flammable vertical surface using four mounting screws. Line of sight should be maintained from both the Remote Unit’s and Base Unit’s antennas to avoid communication dropouts.

Wiring the Base Unit

The Base Unit contains an Ethernet wireless modem and has an RJ-45 cable pass-through at the bottom left of the enclosure. Insert an RJ-45 cable through the cable grip and connect directly to the Ethernet wireless modem. The cable grip can then be tightened to provide strain relief.

For best results, the RJ-45 cable should be connected to a network switch when adding the WDS units to a company network. Otherwise, a cross-over RJ-45 cable may be required.

At the bottom right of the Base Unit enclosure is a cable grip for running the 115V control power wiring. Ethernet and control power wiring should never be run together. Use their respective cable grips.

A typical wiring diagram for the Base Unit can be found in Appendix A.
Wiring the Remote Unit

The Remote Unit contains two cable grips on the bottom of the enclosure. It is important that control and serial (RS-485/RS-422) wiring are run separately. Use twisted-pair shielded cable (e.g. Belden 9842) for wiring to your drives.

**IMPULSE AC drives**: Can be wired as RS-485 (2-wire/4-wire) or RS-422 (4-wire).

**IMPULSE® G+/VG+ Series 2**: The IMPULSE® G+/VG+ Series 2 requires a CMG5M serial option board. To connect multiple IMPULSE® G+/VG+ Series 2 drives, use terminals 1–4 on the CMG5M board as shown in Appendix B.

**OmniPulse DDC / MagnePulse DMC**: The OmniPulse DDC and MagnePulse DMC supports the RS-485 (2-wire) interface only.

Wiring to the Drives

1. Locate the correct terminals.
2. Use twisted-pair shielded wire for connections as indicated in the table below:

| WDS Remote Unit Terminal Block | IMPULSE® G+/VG+ Series 2 CMG5M Board Terminals | IMPULSE® G+/VG+ Series 4 
IMPULSE® G+/VG+ Series 3 
IMPULSE® G+ Mini 
IMPULSE® P3 Series 2 
OmniPulse DSD Control Terminals | OmniPulse DDC MagnePulse DMC | Description |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>R+</td>
<td>1</td>
<td>S+</td>
<td>T1-9 – RS485B (T/R+)</td>
<td>RS-485 signal</td>
</tr>
<tr>
<td>R-</td>
<td>2</td>
<td>S-</td>
<td>T1-8 – RS485A (T/R-)</td>
<td>RS-485 signal</td>
</tr>
<tr>
<td>T+</td>
<td>3</td>
<td>R+</td>
<td>N.C.</td>
<td>RS-485 signal</td>
</tr>
<tr>
<td>T-</td>
<td>4</td>
<td>R-</td>
<td>N.C.</td>
<td>RS-485 signal</td>
</tr>
<tr>
<td>Shield</td>
<td>TC2</td>
<td>TB4, IG</td>
<td>Chassis Ground</td>
<td>Shield</td>
</tr>
</tbody>
</table>

3. Set the terminating resistor.

**NOTE**: Reference the technical manual of the specific drive for more information on the wiring connections.
Terminating Resistor

There is a dipswitch, on the drive, that is used to connect a terminating resistor (120 Ohms) to the serial communications for proper network balancing. This terminating resistor needs to be ON at the end of the line for the RS-485 communications. Use a daisy-chain wiring configuration for connecting multiple drives. The terminating resistor should be turned ON for the drive shown in the diagram below.

**One-to-one connection**

```
Impulse Link Remote
Termination ON  -->  RS485  -->  Impulse Drive
                   Termination ON
```

**Multiple drive connection**

```
Impulse Link Remote
Termination ON  -->  RS485  -->  Impulse Drive
                   Termination OFF

Impulse Drive
Termination OFF

Impulse Drive
Termination OFF

Impulse Drive
Termination OFF

Impulse Drive
Termination ON
```
Chapter 3 - Navigation

IMPULSE®-Link 4.1 WDS is a Windows-based software with easy to use menus and drop-down functions. The user is able to access utilities for uploading/downloading parameters, comparing parameters, saving parameters to a file, accessing the DataLogger function and more, from the easy to navigate toolbar. The main screen allows the user to access more commonly used features.

**New** – Displays the menu to create a new factory default parameter set, based on the drive type, firmware version, model, and kVA.

**Open** – Opens or finds a file containing a parameter set for a specific drive type and firmware version.

**Save** – Saves the active file with its current file name and location.

**Print** – Prints the active parameter set. Select Print options, in the Print window/dialog box.

**Print Preview** – Shows how a file will look when you print it.

**Log** – Shows the status log.

**Help** – Provides information on communication profile settings and troubleshooting, complete Index of VFD fault codes, and a Search function.

**Write to VFD** – Saves all parameter values from the PC to the VFD.

**Read from VFD** - Loads all parameter values from the VFD to the PC.

**Properties** – Displays the properties box to view the properties of the active file.
The following gives a brief summary each of the functions that can be accessed from the navigation toolbar.

**Write Flash** – Allows a binary file to be written to VFD flash memory. (FACTORY USE ONLY)

**Read from VFD** – Loads all parameter values from the VFD to the PC.

**Write to VFD** – Saves all parameter values from the PC to the VFD.

**New** – Opens a dialog to create a new factory default parameter set, based on the drive type, firmware version, model, and kVA.

**Open** – Opens a *.par file containing a parameter set for a specific drive type and firmware version.

**Close** – Closes the parameter file that’s currently open.

**Save** – Saves the active file with its current file name and location.

**Save As** – Saves the active file with a selectable file name and location.

**Print Preview** – Shows how a file will look when you print it.

**Print** – Prints the active parameter set with selectable options in the Print window/dialog box.

**Properties** – Displays the properties of the active file.

**Exit** – Closes this program after prompting you to save any unsaved files.

**Communication** – Allows communication profiles to be added, removed, edited, copied, imported, and exported.

**Preferences** – Settings for access level.

**Custom Defaults** – Allows for maintaining “custom default” parameter files.
Convert – Allows for parameter files to be converted from one firmware version to another (must be within the same drive series).

Compare – Allows for comparison between two different parameter files.

Communication Test – Performs a communication test with the VFD.

Monitor – Displays a select number of monitor parameters (U-parameters); updated continuously.

DataLogger – Opens the DataLogger function.

Keypad Simulator – Emulates the keypad and allows for navigating the keypad menu remotely (this is not available unless hardwired to the keypad port).

Show Error Log – Shows the status of IMPULSE®-Link 4.1 WDS.

Window – Allows for easy parameter window recall and organization. All open files are enumerated at the bottom of this menu for switching between files more easily.

User Manual – Displays the User Manual. (A .pdf reader, such as Adobe Acrobat Reader, must be installed)

Impulse Link Help – Provides information on communication profile settings and troubleshooting, complete index of VFD fault codes, and a Search function.

Magnetek Website – Provides a link to the Magnetek Material Handling website.

Check for Updates – Provides a link to the Magnetek webpage that offers updates.

About – Displays the version number of this software, copyright, and legal notices.
Chapter 4 - Parameter Maintenance

IMPULSE® Link 4.1 WDS software provides flexibility in programming, uploading, downloading, and saving parameters. With full parameter descriptions and visual programming, modifying parameters from your computer has never been easier.

Read from VFD

This function allows you to load the parameter values from a drive. This can be accomplished through the “VFD” drop down menu or by clicking the “Read” icon.

Write to VFD

This function transfers the parameter settings from your PC to the VFD. This can be accomplished via the drop down on the “VFD” menu or by clicking the “Write” icon. Writing to the VFD may result in undesirable operation of your crane, which may lead to bodily injury or damage to machinery. To proceed with the Write to VFD function, you will need to accept that you acknowledge the warning message as shown here. Once you have checked the “I Accept” box, the “Continue Write to VFD” button will be available.
Parameter File Display

Parameter Value Text Color

**Modified Constant**
A parameter with blue text implies that its value is different than its default setting.
- This list should match the modified constants list in the drive, with the exception of A1 parameters.

**Read-Only**
A grayed-out, highlighted parameter implies that it cannot be modified.
- The Access Level of the current parameter set is lower than what is needed for this specific parameter (i.e. changing this parameter from the drive keypad would not be allowed with the current access level).

**Over Maximum**
A parameter with red text implies that its value is greater than its maximum. An invalid value in the PAR file could result in this error.

**Under Minimum**
A parameter with green text implies that its value is less than its minimum. An invalid value in the PAR file could result in this error.

Modifying Parameters

1. Begin modifying a parameter by double-clicking on the setting cell.
2. A drop-down list or edit box will appear.
3. Press “Enter” to accept the change or “Escape” to cancel.

**Drop-down List Example.**

This is displayed for drive parameters with a finite list of options.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Setting</th>
<th>CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1-01</td>
<td>DC Ch Select</td>
<td>Not Used</td>
<td>x</td>
</tr>
<tr>
<td>P1-02</td>
<td>DC Ch Select</td>
<td>11</td>
<td>x</td>
</tr>
<tr>
<td>P1-03</td>
<td>DC Ch Select</td>
<td>12</td>
<td>x</td>
</tr>
<tr>
<td>P1-04</td>
<td>DC Ch Select</td>
<td>13</td>
<td>x</td>
</tr>
<tr>
<td>P1-05</td>
<td>DC Ch Select</td>
<td>14</td>
<td>x</td>
</tr>
<tr>
<td>P1-06</td>
<td>DC Ch Select</td>
<td>15</td>
<td>x</td>
</tr>
<tr>
<td>P1-07</td>
<td>DC Ch Select</td>
<td>16</td>
<td>x</td>
</tr>
<tr>
<td>P1-08</td>
<td>DC Ch Select</td>
<td>17</td>
<td>x</td>
</tr>
<tr>
<td>P1-09</td>
<td>DC Ch Select</td>
<td>18</td>
<td>x</td>
</tr>
<tr>
<td>P1-10</td>
<td>Comm Bus Pt Sel</td>
<td>1</td>
<td>x</td>
</tr>
</tbody>
</table>

**Edit Box Example**

This is displayed for drive parameters with a numeric range.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Setting</th>
<th>CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>E2-01</td>
<td>Input Voltage</td>
<td>220</td>
<td>x</td>
</tr>
<tr>
<td>E2-02</td>
<td>I/F Selection</td>
<td>±80 Hz Saturation</td>
<td>x</td>
</tr>
<tr>
<td>E2-03</td>
<td>Pn Speed</td>
<td>1.0</td>
<td>x</td>
</tr>
<tr>
<td>E2-04</td>
<td>Pn Voltage</td>
<td>230.0</td>
<td>x</td>
</tr>
</tbody>
</table>

Notes:

1. If a change is made and ENTER is not pressed to accept it, when the user clicks on another row or column, the value will revert back to what it was before the change.
2. If a parameter is changed to an invalid value, under the minimum value or over the maximum value, a warning message will be displayed and the value being edited will revert back to what it was before the change.
**Visual Programming**

Visual Programming is an additional editing option targeted towards more complicated parameters that require using a table to calculate a desired setting.

Parameters with a Visual Programming option display an icon.

*To Edit:*
1. Left-click on the Visual Programming icon.
2. Click to place an “X” on the appropriate selections.
3. Choose “OK” to accept the change or “Cancel” to abort.

![Visual Programming Table](image)

**Security / Password Protection**

The “Preferences” drop-down menu allows you to set the access level, username, and password.

By logging out of *Advanced* mode, you will be sent to *User* mode. While in User mode, the drives can only be monitored. Write to VFD and Reset functions are NOT available.

![Preferences](image)
Parameter File Comparison

The “Parameter File Comparison” function, found in the “Tools” drop-down menu, allows for comparison of two different parameter files. Use the “Load” button to select the file you want to view on the left and right side.

Once the parameter files are loaded, you can use the “Show” drop-down to compare:
- all parameters of each file,
- only parameters with equal values,
- only parameters with different values.

Parameters shown in Red are parameters with different values.
Custom Defaults

This function allows for the comparison of your current drive parameters to a custom default set versus factory default. This allows for a quick analysis of incorrect or non-uniform parameter settings within a file, without having to compare multiple files.

Setting Up Your Custom Defaults:

Custom Defaults are organized into Groups and Files. Each Group contains files with a unique combination of drive type, firmware version, and model. Maintenance screens are provided for adding and removing these files.

Alternatively, the user may also copy the entire “CustomDefaults” sub-directory from computer to computer. When IMPULSE®-Link 4.1 first loads, it scans the “CustomDefaults” sub-directory for valid PAR files.

NOTE: The default file location is “C:\Program Files\Electromotive Systems\Impulse Link 4.1”

Using Custom Defaults:

Using Custom Defaults is not much different than viewing Modified Constants. If the selected PAR file matches the drive type, firmware version, and model within one of the Groups, the Group will appear in the drop-down. When a Group is selected, an additional column is displayed and the parameter file is filtered by whether the value matches the custom default (rather than the factory default).
Chapter 5 - Monitor / Drive DataLogger Function

Monitor

The “Monitor” function, in the “Tools” drop-down, displays a select number of monitor parameters (U-parameters) that are continually updated.

Drive DataLogger

The Drive DataLogger function can monitor multiple drives simultaneously while also recording run, fault, and alarm events to file.

NOTE: A displayed fault may be clicked on to bring up corresponding help content.

A DataLogger file (.ds3) contains a limited number of events. When the maximum has been reached, the oldest entry is replaced. For each event, this is a corresponding voltage, current, and frequency recorded at the time the event occurred. For faults and alarms, additional data that occurred just prior to the event is also logged. This is known as Trace data.

Available Events:
- 1400 run events
- 200 alarm events
- 200 fault events

A DataLogger file may be e-mailed for additional troubleshooting assistance.

NOTE: The DataLogger function does not support data logging of IMPULSE®·P3 Series 2 drives.
To Begin

1. Click the check box of the drive(s) you want to monitor.
2. Click the “Start Logging” button.

The left window will change to show a button for each of the drives you selected and the overall status of the drive after it initializes connection.

Each button will display a different color based on the status of the drive profile.

**White background:**
Normal operation of the drive

**Yellow background:**
An alarm is present on the drive

**Red background:**
A fault is present on the drive
This also contains a brief description of the status. The following table lists these brief text messages displayed along with a description for each.

<table>
<thead>
<tr>
<th>Text Displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Drive has an Alarm</td>
</tr>
<tr>
<td>Communication Error</td>
<td>IMPULSE®-Link is having trouble communicating with the drive. An error code will be shown to further assist</td>
</tr>
<tr>
<td>&lt;error code&gt;</td>
<td></td>
</tr>
<tr>
<td>Connected!</td>
<td>IMPULSE®-Link has established connection to the drive</td>
</tr>
<tr>
<td>Connecting…</td>
<td>IMPULSE®-Link is preparing the communication with the drive</td>
</tr>
<tr>
<td>Disconnected</td>
<td>Communication lost between IMPULSE®-Link and the drive</td>
</tr>
<tr>
<td>Drive Not Supported</td>
<td>The drive selected is not supported by the DataLogger function</td>
</tr>
<tr>
<td>Faulted</td>
<td>Drive has a fault</td>
</tr>
<tr>
<td>Forward</td>
<td>Drive is being issued “Forward” command to run.</td>
</tr>
<tr>
<td>Initializing…</td>
<td>IMPULSE®-Link is trying to establish communication with the drive</td>
</tr>
<tr>
<td>Reverse</td>
<td>Drive is being issued “Reverse” command to run.</td>
</tr>
<tr>
<td>Stopped</td>
<td>Drive is stopped</td>
</tr>
<tr>
<td>Zero Spd</td>
<td>Drive is at “Zero Speed”</td>
</tr>
</tbody>
</table>

The right window will show the profile of the drive selected at the top, along with continually updated information. There are 4 main areas displayed:

1) Profile
2) Summary
3) Monitor
4) Status

**Profile** - Displays the drive profile and other information about the drive

**Summary** – Displays current status of drive including last fault or alarm

```
<table>
<thead>
<tr>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Status:</td>
</tr>
<tr>
<td>Accum Runs:</td>
</tr>
<tr>
<td>Accum Faults:</td>
</tr>
<tr>
<td>Accum Alarms:</td>
</tr>
</tbody>
</table>
| Last Fault:    | EF5 - Ext Fault S5  
|                | 01/16/2009 11:47:42 |
| Last Alarm:    | EF5 - Ext Fault S5  
|                | 01/16/2008 11:30:33 |
```

**Status** – Shows the status of input and output terminals along with a visual of the drive status.

```
<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Terminal:</td>
</tr>
<tr>
<td>Output Terminal:</td>
</tr>
<tr>
<td>Drive Status:</td>
</tr>
</tbody>
</table>
```

**Monitor** – Displays selected monitor parameters (U-Parameters).

```
<table>
<thead>
<tr>
<th>Monitor</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Reference</td>
<td>15.00 Hz</td>
</tr>
<tr>
<td>Output Frequency</td>
<td>0.00 Hz</td>
</tr>
<tr>
<td>Output Current</td>
<td>0.0 Amps</td>
</tr>
<tr>
<td>Output Voltage</td>
<td>0.0 VAC</td>
</tr>
<tr>
<td>Bus Voltage</td>
<td>321 VDC</td>
</tr>
<tr>
<td>Torque Reference</td>
<td>0.0 %</td>
</tr>
</tbody>
</table>
```
In the summary window if a Fault or Alarm condition occurs, the DataLogger allows you to click on the Alarm or Fault, and displays troubleshooting information (as shown here).

<table>
<thead>
<tr>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Status:</td>
</tr>
<tr>
<td>Accum Runs:</td>
</tr>
<tr>
<td>Accum Faults:</td>
</tr>
<tr>
<td>Accum Alarms:</td>
</tr>
<tr>
<td>Last Fault:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Last Alarm:</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

The Status window allows for the viewing of input and output terminal status. By using your mouse, you can scroll over the LED to view the meaning. See the example below.

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Terminal: [green LED on Terminal 5]</td>
</tr>
</tbody>
</table>

Terminal 5 is ON
Fault Reset

In the event of a fault condition, you will see the fault icon on either the DataLogger window or the Monitor window as indicated below.

You can reset a fault in the Monitor window or DataLogger window, as long as the drive doesn’t have a Run command and the fault condition no longer exists. Once you click on the fault reset icon (as shown above), a warning message will prompt you to accept that you acknowledge the warning. When resetting a fault remotely, you need to be sure that all personnel and/or operators are notified. Once you have checked the “I Accept” box, the “Continue Fault Reset” button will be available.
Fault / Alarm / Run History

Click on any of the three icons (Fault/Alarm/Run), and the top of the DataLogger will change to show three new tabs. Each tab will allow you to view the Fault, Alarm, or Run History for the drive.

In this window you can view the History for each tab. Clicking on the plus (+) sign will show additional information related to the fault or alarm.

<table>
<thead>
<tr>
<th>Fault #</th>
<th>Description</th>
<th>Run #</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FF5 - Ext Fault S5</td>
<td>None</td>
<td>01/16/2008</td>
<td>15:53:20</td>
</tr>
<tr>
<td>2</td>
<td>FF5 - Ext Fault S5</td>
<td>12</td>
<td>01/16/2008</td>
<td>15:53:31</td>
</tr>
<tr>
<td>3</td>
<td>FF5 - Ext Fault S5</td>
<td>None</td>
<td>01/16/2008</td>
<td>15:57:31</td>
</tr>
<tr>
<td>4</td>
<td>FF5 - Ext Fault S5</td>
<td>None</td>
<td>01/16/2008</td>
<td>15:58:50</td>
</tr>
<tr>
<td>5</td>
<td>FF5 - Ext Fault S5</td>
<td>13</td>
<td>01/16/2008</td>
<td>16:27:57</td>
</tr>
<tr>
<td>6</td>
<td>FF5 - Ext Fault S5</td>
<td>None</td>
<td>01/16/2008</td>
<td>16:28:34</td>
</tr>
</tbody>
</table>

Trace Data

<table>
<thead>
<tr>
<th>Trace No</th>
<th>Date</th>
<th>Time</th>
<th>U1:01</th>
<th>U1:02</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>01/16/2008</td>
<td>16:27:57</td>
<td>60.00</td>
<td>60.00</td>
</tr>
<tr>
<td>4</td>
<td>01/16/2008</td>
<td>16:27:56</td>
<td>60.00</td>
<td>65.00</td>
</tr>
<tr>
<td>3</td>
<td>01/16/2008</td>
<td>16:27:56</td>
<td>60.00</td>
<td>60.00</td>
</tr>
<tr>
<td>2</td>
<td>01/16/2008</td>
<td>16:27:55</td>
<td>60.00</td>
<td>59.53</td>
</tr>
<tr>
<td>1</td>
<td>01/16/2008</td>
<td>16:27:55</td>
<td>60.00</td>
<td>58.30</td>
</tr>
</tbody>
</table>
Chapter 6 - Additional Menu Features

Print Preview

IMPULSE®-Link 4.1 WDS provides a compact printing mode that displays all drive parameters in only 1-2 pages. It also prints a more detailed mode that lists descriptions as well as units for each parameter.

Compact Parameter Print Preview

![Compact Parameter Print Preview](image1)

**NOTE:** Only parameters that are viewable in the Parameters Window will be printed.

Detailed Parameter Print Preview

![Detailed Parameter Print Preview](image2)

**Printer Name** – Select a printer.

**Print Mode** - Allows the user to choose the printing style.
- **Compact** mode (1-2 pages) provides parameter name and setting value.
- **Detailed** mode provides parameters, descriptions, setting, values, and units as well as “modified” information.
- **As shown** prints all of the information as shown on the screen.

**OK** – Prints the active parameter set to the selected printer in the chosen format.

**Cancel** – Closes this dialog box without printing. Changes to Customer Name, Application, and Job Number are not saved.

Text placed in the Customer Name, Application, and Job Number fields appear on the printout.

Print

![Print](image3)

**Printer Name** – Select a printer.

**Print Mode** - Allows the user to choose the printing style.
- **Compact** mode (1-2 pages) provides parameter name and setting value.
- **Detailed** mode provides parameters, descriptions, setting, values, and units as well as “modified” information.
- **As shown** prints all of the information as shown on the screen.

**OK** – Prints the active parameter set to the selected printer in the chosen format.

**Cancel** – Closes this dialog box without printing. Changes to Customer Name, Application, and Job Number are not saved.

Text placed in the Customer Name, Application, and Job Number fields appear on the printout.

**NOTE:** Only parameters that are viewable in the Parameters Window will be printed.
Parameter File Conversion

The “Convert” function, under the “Tools” menu, allows parameter files to be converted from one firmware version to another (within the same drive series).

Source – Specifies the file to be converted.

Flash ID – Specifies the firmware version that the file will be converted to.

Destination – Specifies the Destination location and filename.

Convert - Converts the parameter file specified in “Source” to the format specified in the firmware version in the Flash ID. The converted file is saved to the filename and location specified in “Destination”.

Keypad Simulator

The “Keypad Simulator” function communicates with an IMPULSE®•G+/VG+ Series 3, IMPULSE®•G+/VG+ Series 2, and IMPULSE®•P3 Series 2 drive exactly as the physical keypad does. This allows for remote keypad menu navigation.

NOTE: This function is only available when IMPULSE®•Link 4.1 WDS is connected via the drive’s keypad 1CN connector (instead of the standard RS-485 connection) – primarily for training purposes.

If you attempt to run the keypad simulator while connected via a RS-485 connection, a CF00 Comm Error will occur.

Keypad Simulator NOTES:

1. To Activate, select the correct drive profile from the dropdown and click the ▶️ button.
2. The Keypad will automatically close if any communication function, such as Upload and Download, or a new offline parameter set is created from the Controller Properties window.
3. The RUN command has been disabled for safety reasons.
4. If the drive is put into “Program Mode” and not returned to “Run Mode”, the user will be unable to run the drive.
Viewing Parameters

The “View” drop-down box allows filtering of parameters based on parameter group or by modified from factory defaults or from custom defaults.

Copying to the Clipboard

The user has the ability to copy displayed parameter information to a preferred word processor or spreadsheet.

To do this, select one or more rows and either press Ctrl-C or right-click to display the context menu, shown to the right. The copied information is available to be pasted in either HTML format or ASCII text.

Tip: Change from full row selection mode to single cell selection mode by doing the following:
1. Click and hold the left mouse button over any row.
2. Drag the mouse down while the left-mouse button is still being held. An icon will replace your mouse pointer.
3. While still holding the left mouse button, click the right mouse button. The icon will become skinner and you will no longer be restricted to selecting the whole row. Repeat to return to full row mode.
Chapter 7 - Troubleshooting

The IMPULSE®•Link 4.1 WDS Help section provides the following:

- Reference to Drive faults and corrective actions.
- Reference to IMPULSE®•Link error codes and corrective actions.
- Communication profile settings overview.

Drive Fault References

IMPULSE®•Link 4.1 WDS offers built-in Help screens for the drive faults and alarms. The Help screens provide advanced diagnostics allowing you to troubleshoot your drive from your PC. When you click on the fault, the help screen provides the fault code, fault name/description, and the corrective action.

Or you can simply go to the Drive Fault References for a complete list of faults specific to the individual drive.
Communication Error References

The Help function provides an overview of possible errors that could occur in IMPULSE® Link 4.1 WDS:

By clicking on the type of error, you will be provided the fault code with description and corrective action.
Communication Profile Test

The “Communication Profile Test Utility” is a tool to assist in troubleshooting communication difficulties. It performs the following sequence:

1. Opens the communication port with the selected settings. If the port opens successfully, the port exists and IMPULSE®-Link has access to it.
2. Sends a loop-back test message to establish whether a valid device exists with the settings in the profile. If the loop-back fails, the device may not be powered, present or supported.
3. Identifies the drive model and version. If the discovered type is unknown, IMPULSE®-Link does not support it.

NOTE: If any of the above steps fail, an error message is prompted to the user with an error code (i.e. CE100). For further troubleshooting reference the error code in the help section.

Status Log

This function, also found in the “Tools” drop-down menu, brings up an additional window showing various status details of IMPULSE®-Link 4.1 WDS.
Chapter 8 - Appendices

Appendix A: Wiring for IMPULSE®-Link WDS Base Unit
Appendix B: Serial Wiring for IMPULSE®-Link WDS Remote Unit

IMPULSE G+/VG+ Series 4, G+/VG+ Series 3, P3 Series 2, and G+ Mini

[Diagram of serial wiring connections]
Appendix C: Termination Resistor Location

The following diagrams illustrate the location of the terminating resistor for each family of drives.

**IMPULSE®-G+/VG+ Series 4:**
DIP switch S2 is located on the interface board.

*(Notice that the “ON” position is with the switch to the right side.)*

**IMPULSE®-G+/VG+ Series 3:**
DIP switch S1 is located on the interface board.

*(Notice that the “ON” position is with the switch to the right side.)*

**IMPULSE®-G+/VG+ Series 2:**
DIP switch SW1 is found on the left side of the CMG5M RS-485 option card.

*(Notice that the “ON” position is with the switch to the left side.)*
**IMPULSE®-G+ Mini:**

DIP switch S2 is located above the control terminals and to the right of CN5.

*(Notice that the “ON” position is with the switch to the right side.)*

---

**IMPULSE®-P3 Series 2:**

DIP switch SW2 is located above the control terminals.

*(Notice that the “ON” position is with the switch to the right side.)*

---

**OmniPulse DDC & MagnePulse DMC:**

Terminal jumpers LK2, are located near the center of the control board. With the jumper on pins 1 and 2, the terminating resistor is connected. With the jumper on pins 2 and 3, the terminating resistor is not connected.
## Appendix D: Quick Reference

### G+/VG+ Series 4

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus Address</td>
<td>H5-01 01 ~ 1F</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>H5-02 3: 9600 Baud</td>
</tr>
<tr>
<td>Parity Select</td>
<td>H5-03 0: No Parity</td>
</tr>
</tbody>
</table>

**Note:**
- 3 = 9600
- 4 = 19200

### G+/VG+ Series 3

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus Address</td>
<td>H5-01 01 ~ 1F</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>H5-02 3: 9600 Baud</td>
</tr>
<tr>
<td>Parity Select</td>
<td>H5-03 0: No Parity</td>
</tr>
</tbody>
</table>

**Note:**
- 3 = 9600
- 4 = 19200

### G+/VG+ Series 2 (SI-K2 option card)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus Address</td>
<td>H5-01 01 ~ 1F</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>H5-02 3: 9600 Baud</td>
</tr>
<tr>
<td>Parity Select</td>
<td>H5-03 0: No Parity</td>
</tr>
</tbody>
</table>

* See Appendix C for wiring connections

### G+ Mini

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus Address</td>
<td>H05.01 01 ~ 1F</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>H05.02 03: 9600 Baud</td>
</tr>
<tr>
<td>Parity Select</td>
<td>H05.03 00: No Parity</td>
</tr>
</tbody>
</table>

**Note:**
- 03 = 9600
- 04 = 19200

### P3 Series 2

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus Address</td>
<td>n253 01 ~ 1F</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>n254 2: 9600 Baud</td>
</tr>
<tr>
<td>Parity Select</td>
<td>n255 2: No Parity</td>
</tr>
</tbody>
</table>

**Note:**
- 2 = 9600
- 3 = 19200

### OmniPulse DDC and MagnePulse DMC

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>G16 9600</td>
</tr>
<tr>
<td>RS232/RS485 Select</td>
<td>G17 RS485</td>
</tr>
<tr>
<td>Serial Format</td>
<td>G18 8N1</td>
</tr>
<tr>
<td>Modbus Address</td>
<td>G19 1 ~ 31</td>
</tr>
</tbody>
</table>

* Shield: Chassis Ground